
User's Manual

Thank you very much for purchasing this product.

➢ To ensure correct and safe usage with a full understanding of this product's performance, please be
sure to read through this manual completely and store it in a safe location.

➢ Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.
➢ The contents of this operation manual and the specifications of this product are subject to change

without notice.
➢ The operation manual and the product have been prepared and tested as much as possible.  If you

find any misprint or error, please inform us.
➢ Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may

occur through use of this product, regardless of any failure to perform on the part of this product.
➢ Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may

occur with respect to any article made using this product.
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For Canada

CLASS A                    NOTICE

This Class A digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

CLASSE A                   AVIS

Cet appareil numérique de la classe A respecte toutes les
exigences du Règlement sur le matériel brouilleur du
Canada.

For the USA

FEDERAL COMMUNICATIONS COMMISSION
RADIO  FREQUENCY  INTERFERENCE

STATEMENT

This equipment has been tested and found to comply with the
limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules.
These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated
in a commercial environment.
This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference
to radio communications.
Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Unauthorized changes or modification to this system can void
the users authority to operate this equipment.

The I/O cables between this equipment and the computing
device must be shielded.

ROLAND DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN  431-2103
MODEL NAME : See the MODEL given on the rating plate.
RELEVANT DIRECTIVE : EC LOW VOLTAGE DIRECTIVE (73/23/EEC)

EC ELECTROMAGNETIC COMPATIBILITY DIRECTIVE (89/336/EEC)
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Used for instructions intended to alert the user to the risk of death or severe
injury should the unit be used improperly.

About WARNING and CAUTION Notices

Used for instructions intended to alert the user to the risk of injury or material
damage should the unit be used improperly.

* Material damage refers to damage or other adverse effects caused with re-
spect to the home and all its furnishings, as well to domestic animals or pets.

WARNING

CAUTION

About the Symbols

The  symbol alerts the user to important instructions or warnings.  The specific meaning of
the symbol is determined by the design contained within the triangle.  The symbol at left means
"danger of electrocution."

The  symbol alerts the user to items that must never be carried out (are forbidden).  The
specific thing that must not be done is indicated by the design contained within the circle.  The
symbol at left means the unit must never be disassembled.

The  symbol alerts the user to things that must be carried out.  The specific thing that must be
done is indicated by the design contained within the circle.  The symbol at left means the power-
cord plug must be unplugged from the outlet.

 To Ensure Safe Use

Improper handling or operation of this machine may result in injury or damage to property.
Points which must be observed to prevent such injury or damage are described as follows.

 Incorrect operation may cause injury

WARNING

Never allow children near the machine.
The machine includes locations and components
that pose a danger to children, and major acci-
dent, including injury, blindness, or choking, may
occur.

Do not disassemble, repair, or modify.
Doing so may lead to fire or abnormal opera-
tion resulting in injury.

CAUTION

Install on a stable surface.
Failure to do so may result in the unit tipping
over, leading to injury.

Be sure to follow the operation proce-
dures described in this manual.
Failure to follow the procedures may cause sud-
den operation or the like of the machine, which
may result in unexpected injury.
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 Danger of electrical short, shock, electrocution, or fire

WARNING

Do not use with any electrical power sup-
ply that does not meet the ratings dis-
played on the AC adapter.
Use with any other power supply may lead to
fire or electrocution.

Do not use with any power supply other
than the dedicated AC adapter.
Use with any other power supply may lead to
fire or electrocution.

Never operate the machine or insert or
remove its power plug with wet hands.
Doing so may result in electrical shock or elec-
trocution.

Never allow the machine to get wet, or
apply gasoline, thinner, or any other flam-
mable material to it.
Current leakage may cause electrical shock, elec-
trocution, or combustion and fire.

Never allow hairpins, coins, matches, or
any other object to get inside the machine.
Doing so may cause and electrical short, result-
ing in shock or electrocution, or the inserted
object may catch fire.

Never place gasoline, alcohol, thinner, or
any other flammable material near the
machine, or use an aerosol spray close to
the machine.
Doing so may cause fire.

Never damage the power cord or pull it
with force.
Doing so may tear the cord's insulation, causing
an electrical short and resulting in electrical
shock, electrocution, or fire.

Never place any object on the power cord,
bend the power cord using excessive force,
or allow the power cord to become de-
formed.
If it becomes deformed, the deformed location
may grow hot and cause fire.

Never use the machine with the power
cord bound into a bundle or roll.
If the cord is in a bundle or roll, it may grow hot
and cause fire.

Never use any power cord other than the
power cord included with the machine.
Also, never use a power strip or extension
cord.
The power strip or extension cord may grow
hot and cause fire.

Do not use with a damaged AC adapter,
power cord or plug, or with a loose elec-
trical outlet.
Doing so may lead to fire, electrical shock, or
electrocution.

When unplugging the electrical power
cord from the power outlet, grasp the plug,
not the cord.
Unplugging by pulling the cord may damage it,
leading to fire, electrical shock, or electrocution.

In the event of an abnormal state (such as
smoke or sparks, odor or burning or un-
usual noise), immediately unplug the
power cord.
Failure to do so may result in fire, electrical
shock, or electrocution. Immediately disconnect
the power cord and contact your Roland DG
Corp. service center.

When not in use for several hours, unplug
the power-cord plug from the electrical
outlet.
Failure to do so may result in danger of electri-
cal shock, electrocution or fire due to deterio-
ration of electrical insulation.
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 The head area becomes hot

WARNING

Never touch the head immediately after
printing has finished.
Doing so may cause burns.
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 Warning Label

Warning label is affixed to make areas of danger immediately clear. The meaning of the label is
as follows. Be sure to heed its warnings.
Also, never remove the label or allow it to become obscured.

Caution: High Temperature
Never touch immediately after printing.
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Important Notes on Handling and Use

This machine is a precision device. To ensure the full performance of this machine, be sure to
observe the following important points. Failure to observe these may not only result in loss of
performance, but may also cause malfunction or breakdown.

This machine is a precision device.

➢ Handle carefully, and never subject the machine to impact or excessive force.
➢ Never print material outside the range of specifications.

Install in a Suitable Location

➢ Install in a location having the specified temperature and relative humidity.
➢ Install in a quiet, stable location offering good operating conditions.

Important Notes on Connecting the Cables

➢ Connect the power cord and the computer's input and output cables securely.

When Moving the Machine

➢ When moving the machine, be sure to support it at the bottom using two hands. Attempting to move the
machine by holding it at a different location may result in damage.

➢ When moving the machine, turn the knob to secure the head in place.
➢ When moving the machine to another location, be sure to attach the retainers. Attempting moving without

attaching the retainers may result in damage.

Printing

➢ Never attempt to perform printing on the edges or over holes in printing material.
➢ Printing results may vary according to the original data, the material printed, and the details of settings. Before

you perform actual printing, we recommend carrying out test printing.
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Chapter 1
Getting Started
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1-1 About the Machine

Features

This machine is a metal printer. It prints images by striking detailed points using a marking pin mounted in a head.
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Names and Functions

Main Unit

Head

Adhesive sheet
Material is placed on the adhesive sheet, which then holds
the material in place. This lets you immobilize objects
without having to use commercially available tape or the
like.

Head unit
This moves up and down, bringing the
tip of the head (the marking pin) in
line with the surface of the material.

Power/Movement button
Pressing this makes the light come on and switches
on the power. Pressing it while the unit is on moves
the table to the material-mounting location (toward
the front of the unit) or to the material-printing loca-
tion.
To switch off the power, you hold down the button
for one second or longer.

Table

Knob
This secures the head unit in place.

Cover

USB connectorPower-code connector

Brush
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Marking pins
Nine pins are arranged in the head. Printing
is performed using one of these pins.

Head
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1-2 About the Documentation

Included Documentation

The following documentation is included with the machine.

MPX-70 User's Manual (this manual)

This explains how to install and set up the machine, how to install and set up the software, how to perform printing,
and other such matters.

Dr. METAZA2 online help

This is the operation manual for the Dr. METAZA2 program included with the machine. Installing and setting up the
software enables you to view the documentation.
To view the online help, follow the procedure below.

From the [Start] menu, click [All Programs] (or [Programs]).
Click [Roland Dr. METAZA2], then click [Dr. METAZA2 Help].
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1-3 Checking the Included Items

The following items are included with the machine. Make sure they are all present and accounted for.

Power cord

User's manual
(This document)

CD-ROMUSB cable

AC adapter Test-use printing material
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Chapter 2
Getting Ready to Print
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2-1 Installation

Deciding On an Installation Site

Install the machine on a stable base in a stable location. Also, use the machine in a location having the correct
operating environment (temperature of 10 to 30 °C and relative humidity of 35 to 80% [with no condensation]).
Use in an unsuitable location may result in malfunction or breakdown.

CAUTION Install on a stable surface.
Failure to do so may result in the unit tipping over, leading to injury.

Unsuitable Installation Sites

➢ Locations subject to large fluctuations in temperature or humidity
➢ Locations subject to shaking or vibration
➢ Locations where the floor is tilted, not level, or unstable
➢ Dusty locations
➢ Locations exposed to direct sunlight or near air-conditioning or heating equipment
➢ Locations exposed to considerable electrical or magnetic noise, or other forms of electromagnetic energy
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Removing the Protective Material

Protective material is attached to protect the machine from vibration and the like during transportation. Remove this
once the machine is installed.

➢ Be sure to remove the protective material. Any that remains may cause breakdown when the power is switched
on.

➢ The protective material is required when moving the machine. Be sure not to discard it.

Procedure

➊ Loosen the knob.
The head unit rises.

➋ Remove the protective material.

Knob

Protective material

Head unit

Protective material
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2-2 Connecting the Cables

Connecting the Power Cord

WARNING Do not use with any electrical power supply that does not meet the ratings dis-
played on the AC adapter.
Use with any other power supply may lead to fire or electrocution.

Important Notes on the Power Cord

WARNING Never damage the power cord or pull it with force.
Doing so may tear the cord's insulation, causing an electrical short and resulting in electri-
cal shock, electrocution, or fire.

WARNING Never place any object on the power cord, bend the power cord using excessive
force, or allow the power cord to become deformed.
If it becomes deformed, the deformed location may grow hot and cause fire.

WARNING Never use the machine with the power cord bound into a bundle or roll.
If the cord is in a bundle or roll, it may grow hot and cause fire.

WARNING Never use any AC adapter and power cord other than the AC adapter and power
cord included with the machine. Also, never use a power strip or extension cord.
The power strip or extension cord may grow hot and cause fire.

WARNING Do not use with a damaged AC adapter, power cord or plug, or with a loose electri-
cal outlet.
Doing so may lead to fire, electrical shock, or electrocution.

Power-cord connector

AC adapter

Power cord
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Connecting to the Computer

You make the connection to the computer using the included USB cable.
Be sure to make the connection between the machine to the computer during the course of installing the driver.
Driver installation may fail and the machine may become unusable if you connect a USB cable before starting install-
ing the driver.

Important Notes on USB Connection

➢ Never use a USB hub or the like.
➢ Connect one single machine to a single computer. Never connect two or more machines to one computer.

USB cable (included)

DO NOT connect a USB
cable at this point.

Machine

Computer
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2-3 Installing and Setting Up the Software

Overview of the Included Software

The included CD-ROM contains the following software.

Dr. METAZA2

This is a program for printing images on the surface of printing material using this machine. It enables you import and
crop images to print, and perform editing to add text, boxes, and the like.

MPX-70 Head Manager

This is a utility for adjusting the head. Run it when you replace the head or adjust the marking pins.

Windows-based drivers

These are necessary for sending data from Windows to the machine. Be sure to install them.

System Requirements

System Requirements for Installing the Software

System Requirements for USB Connection

Making a USB connection with Windows requires use of a computer that meets all of the following system require-
ments. Please note that other configurations cannot be supported.

Operating system
Computer

Drive
Monitor

Memory (RAM)
Free hard-disk space required for

installation
Interface

Windows 98 SE (Second Edition)/Me/2000/XP

Computer running Windows (Pentium processor or better recommended)

CD-ROM drive

16-bit color (High Color) video card with a resolution of 800 x 600

64 MB or more recommended

10 MB

USB port

Operating system
Computer

Windows 98 SE (Second Edition)/Me/2000/XP

1) Computers preinstalled with Windows 98 SE/Me/2000/XP at the time of purchase
(This includes such computers later upgraded to Windows Me/2000/XP.)

2) Computers on which USB operation is assured by the manufacturer of computers
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Installing the Driver

Never make the connection to the computer before installing.

Keep the machine and the computer unconnected until you carry out this installation operation. Failure to follow
the correct procedure may make installation impossible.

☞  p 75 "What to Do If Installation Is Impossible"

➊ Before you start installation and setup, make sure the USB cable is not connected.

➋ Log on to Windows. If you are installing under Windows 2000/XP, log on as "Administrators” right.

➌ ➀ Insert the included CD-ROM into the CD-
ROM drive.
After a short wait, the setup menu shown at left ap-
pears.
➁ Click [METAZA Driver Install].
An Installation and Setup Guide matched to the basic
software on your computer is displayed.
If you're using Windows 98 SE/Me/2000, the Installa-
tion and Setup Guide and the Setup program appear.

➍ Follow the instructions in the Installation and Setup Guide to finish installing.

If the [Driver Setup] Window Doesn't Appear

If you're using Windows 98 SE/Me/2000 and the Setup program doesn't appear, first check the taskbar at the
bottom of the screen. If [Driver Setup] is displayed, the program is running. Go to the taskbar and click [Driver
Setup] to display the window for the Setup program.

Installation and Setup Guide Setup program
(Windows 98 SE/Me/2000)

Click this.

Taskbar
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Installing Dr.METAZA2
Procedure

➊ ➀ Display the setup menu.
➁ Click [Dr.METAZA2 Install].

➋ Thereafter, follow the instructions in the messages to complete installation and setup.

Installing MPX-70 Head Manager
Procedure

➊ ➀ Display the setup menu.
➁ Click [MPX-70 Head Manager Install].

➋ Thereafter, follow the instructions in the messages to complete installation and setup.
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2-4 Dr. METAZA2 Settings

Making the Setting for the Printer

After you finish installing and setting up Dr. METAZA2, continue by making the setting for the printer. Be sure to make
the setting before use.

Procedure

➊ Click [Start], then click [All Programs] (or [Pro-
grams]).
Click [Roland Dr. METAZA2], then click [Dr.
METAZA2].

➋ Go to the [File] menu and click [Print Setup].
The [Print Setup] dialog box appears.

➌ ➀ Click the arrow shown in the figure,
then select [Roland MPX-70].
➁ Click [OK].
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Chapter 3
Performing Printing
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3-1 Switching the Power On and Off

Switching the Power On and Off

Before You Switch On the Power

Before you switch on the power, be sure to loosen the knob and raise the head.
Otherwise the head may scrape and damage the adhesive sheet.

Switching On the Power

➀ Open the cover.
➁ Loosen the knob.
Loosen just enough for the head unit to rise.
➂ Press the Power/Movement button.
The light comes on. The table moves and initialization begins. The
power-on initialization performs origin detection, and so a noise
may be heard.

Switching Off the Power

Hold down the Power/Movement button for one second or longer.
The light goes dark and the power is switched off.

Power/Movement button

Cover

Knob

Head unit
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3-2 Starting Dr. METAZA2

Starting Dr. METAZA2

Click [Start], then click [All Programs] (or [Pro-
grams]).
Click [Roland Dr. METAZA2], then click [Dr.
METAZA2].

After the opening screen, the screen for Dr. METAZA2 appears.

Names and Functions of Dr. METAZA2 Screen Items

Margin
The gray area indicates the margin. The margin
areas are not printed. The default margin is 1 mm.

Toolbar
The toolbar is provided with buttons for running
Dr.METAZA2 commands such as [Open...] and
[Save]. Moving the mouse pointer over a button
displays a brief description of the button's func-
tion.

Menu Bar
Runs the various commands for Dr.METAZA2.

Material
The combined black and gray areas indicate the
material.
To decide on the size and shape of the material,
then from the [File] menu, click [Material Setup].

Grid
This is a grid of lines displayed on the screen. It
serves as a guide for positioning images and text.
To hide the displayed grid, click  to clear the
selection.

Status Bar
This shows Dr.METAZA2's state of operation and
provides brief descriptions of commands.
This also shows amount of zoom in or zoom out
for the image.

Centerline
This indicates the horizontal center
location of the window.

Cursor location
This indicates the present location of the cursor. You
can use it to check the locations of images and text.
The position at the center of the window (where the
two centerlines intersect) is (0, 0).

Centerline
This indicates the vertical center location of the
window.
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3-3 Getting Ready to Print

The Printing Area

The machine's printing area is as follows.

Preparing Material to Print

Prepare material that meets all of the following conditions.
Loading material that is larger or thinner than this may cause the material to warp during printing and strike the head,
damaging the marking pin.

Conditions for Materials that Can Be Printed

Center line

Center
line

Printing area
(50 x 50 mm (1-15/16 x 1-15/16 in.))

50 mm

50 mm

80 mm

80 mm

Thickness

Size

0.3 to 20 mm  (0.01 to 0.8 in.)

Length (or width) of 90 mm (3-9/16 in.) or less

* Note that even if thickness and size are within the range as described above, it may not be possible
to perform printing correctly on materials that warp when struck. Refer to the table below, which
provides a general guide to printable sizes according to thicknesses.

Thickness
2.0 mm (0.08 in.)

1.5 mm (0.06 in.)

1.0 mm (0.04 in.)

0.5 mm (0.02 in.)

0.3 mm (0.01 in.)

2.0 mm (0.08 in.)

1.5 mm (0.06 in.)

1.0 mm (0.04 in.)

0.5 mm (0.02 in.)

0.3 mm (0.01 in.)

2.0 mm (0.08 in.)

1.0 mm (0.04 in.)

Material
Aluminium

Brass or copper

Stainless steel

Printable material size (general guide)
Length (or width) of 60 mm (2-3/8 in.) or less

Length (or width) of 40 mm (1-9/16 in.) or less

Length (or width) of 30 mm (1-3/16 in.) or less

Length (or width) of 20 mm (3/4 in.) or less

Length (or width) of 20 mm (3/4 in.) or less

Length (or width) of 60 mm (2-3/8 in.) or less

Length (or width) of 40 mm (1-9/16 in.) or less

Length (or width) of 30 mm (1-3/16 in.) or less

Length (or width) of 15 mm (9/16 in.) or less

Length (or width) of 15 mm (9/16 in.) or less

Length (or width) of 60 mm (2-3/8 in.) or less

Length (or width) of 40 mm (1-9/16 in.) or less

Top view of the table
Expanded printing area
(80 x 80 mm (3-1/8 x 3-1/8 in.))
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Hardness of surface
to print

Cross-section of
printing material 

Vickers hardness (HV) of 200 or less
* Note that materials which may crack or split by printing (such as glass, stone, precious
stones, china, and porcelain) cannot be printed even if hardness is within the preceding range.
Attempting to print such materials may damage the machine.

Flat, with no difference in level
The printed surface must be level when the material is placed on the table.

Edge of the
material is too
high.

Surface to print
is not straight.

Back surface is
uneven.

Back surface is
curved.

Preparing the Image

Prepare an image (such as a photograph or drawing) for printing.
Data in JPEG or BMP format can be used with Dr. METAZA2.
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3-4 Loading Material

Mounting Material on the Table
Procedure

➊ ➀ Open the cover.
➁ Loosen the knob.
Loosen just enough for the head unit to rise.
➂ Press the Power/Movement button to move the table to
the front of the machine.

➋ Place the material on the table and press down on it gently
to secure it in place.

How to Place Material

Place the material at the center of the scale on the table.

About the Adhesive Sheet

➢ Buildup of dust or the like on the adhesive sheet can reduce the sheet's adhesive force, making it difficult to
secure material in place. If the adhesive force has been reduced, then wash the adhesive sheet.

☞  p 62 "Cleaning the Adhesive Sheet"

➢ Never rub the surface of the adhesive sheet with force. Doing so may damage the surface and reduce its
adhesive strength.

Center line

Table
Material

Knob

Power/Movement button

Cover

Head unit

Center of the material

Center line

Table
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➌ Press the Power/Movement button.
The table moves to the center.

➍ ➀ Press the location shown in the figure to lower the head
unit slowly to where it touches the material.
➁ Keeping the area shown in the figure clamped, turn the
knob to secure the head unit in place.

Notes on Loading Material

When you lower the head unit, the metal bar also descends, and contacts the material. Secure the knob in place at the
location where contact is made with the material. The metal portion rises slightly when released, but this does not
affect the loading of the material.

Important!

➢ Lower the head unit slowly. Lowering it too quickly or forcefully may damage the surface of the material.
➢ When you lower the head unit, be sure to press it at the location specified in the procedure. Pressing it at

another area may cause inaccurate height alignment.

➎ Close the cover.

Detaching the Material

Loosen the knob, raise the head, then remove the material.
If the material is difficult to detach, inserting a thin, flat object (such as a piece of stiff paper or cardboard) between the
adhesive sheet and the material may make it easier to dislodge.

Power/Movement button

Lower the metal bar to a location where
it touches the material.

Knob

Press here.

Cover
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3-5 Creating Printing Data

This section describes how to create data, using printing of a plate like the one shown below as an example.

Step 1 : Decide on the Size and Shape of the Material

Important Notes on Printing

Be sure to ensure a margin of 1 mm or more at each edge of the material. Also, avoid printing at areas where there
are holes in the material. The marking pin may be damaged if it strikes an edge or the like on the material.

Procedure

Enter the material's size (outer dimensions), then choose the shape.
In this example, enter 24 mm by 27 mm for the size and choose "quadrilateral" as the shape.

➊ Go to the [File] menu and click [New].
The [Material Setup] dialog box appears.

➋ ➀ For the material's size, enter 24 mm for [Width] and 27
mm for [Height].
➁ Choose [ ] for the shape of the material.
➂ Click [OK].
A quadrilateral measuring 24 mm by 27 mm appears in the win-
dow, with 1 mm margin formed around the quadrilateral.

1 mm 1 mm

Printing areaPrinting areaPrinting areaPrinting area

The printing area
lies over a hole.

The printing area
extends beyond the
material.

No margins are
present at the edges
of the material.

27 mm
(1-1/16 in)

24 mm
(15/16 in)

1 mm(0.039in.)
(Margin)
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Step 2 : Import the Image

Here you import the image to print. Prepare an image file to import.

Procedure

➊ Go to the [File] menu and click [Import].
The [Open] dialog box appears.

➋ ➀ At [Look in], select the location of the file.
➁ At [Files of type], select either [Bitmap file] or
[JPEG file].
➂ Select the file you want.
√ Click [Open].
The specified image is imported and displayed so as to
match the size of the material.

27 mm

24 mm

1 mm

1 mm
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Step 3 : Save the File

Save the printing data in a file.

Procedure

➊ Go to the [File] menu and click [Save As].
The [Save As] dialog box appears.

➋ ➀ For [Save in], specify where to save the file.
➁ Type in a file name.
➂ Click [Save].
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3-6 Starting Printing

Starting Printing
Procedure

➊ Go to the [File] menu and click [Print].
The [Print] dialog box appears.

➋ ➀ Make sure [Roland MPX-70] is chosen as the
printer name.
➁ Click [Properties].

➌ ➀ Click the [Image Correction] tab.
➁ Select [Material].
Select either the composition or the product code of
the material.
➂ Click [OK].

Selection of the Material

When you select the composition of the loaded material, printing is performed using an optimal striking force for the
composition.

☞  p 57 "A Wide Variety Settings You Can Make with the Driver"
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➍ Click [OK].
The printing data is sent to the machine and printing
starts.

➎ ➀ After printing has finished, open the cover.
➁ Loosen the knob.
➂ Detach the material.
If the material is difficult to detach, inserting a thin, flat object (such
as a piece of stiff paper or cardboard) between the adhesive sheet
and the material may make it easier to dislodge.

When Printing Ends

After printing has finished, be sure to loosen the knob and raise the head.
This prevents damage to the head and the adhesive sheet.

Cover

Knob
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Stopping Printing Operations

➊ Windows XP
Click [Start], then click [Control Panel].
Click [Printers and Other Hardware], then click [Printers and Faxes].
Windows 98 SE/Me/2000
Click [Start].
Click [Settings], then click [Printers].

➋ Double-click the [Roland MPX-70] icon.

➌ At the [Printers] menu, click [Cancel All Documents] (or [Purge Print Documents]).

➍ If you're using Windows XP, then click [Yes].

➎ Make sure the printing data has disappeared from the window and operation of the machine has
stopped.

➏ Hold down the Power/Movement button for one second
or longer to switch off the power.

Power/Movement button
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4-1 Tips and Tricks for Image Layout

Tips and Tricks for Image Layout

Lay out the image and create data like the following.

Completed view

Step 2 : Adjust the Location and Size of
the Image
☞ p 42 "Step 2 :  Adjust the Location and Size of the Image"

Step 3 : Enclose the Image in a Circle
☞ p 43 "Step 3 : Enclose the Image in a Circle"

Original image

Step 1 : Cut Out the Required Image
☞ p 41 "Step 1 : Cut Out the Required Image"

Make the settings for the material.
☞ p 32 "Step 1 : Decide on the Size and Shape of the Material"

Import the image.
☞ p 33 "Step 2 : Import the Image"

Trim away everything
except the area to print.

Trim the original image
to leave just the
required portion.

Completed  data
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Step 1 : Cut Out the Required Image

Trim the original image to leave just the required portion.

➊ ➀ Click .
➁ Click the image.

➋ At the [Object] menu, click [Trimming].
The [Trimming Picture] dialog box appears.

➌ ➀ Click [Free].
➁ Drag inside the shaded-line box to
change the location to trim.
Drag the pointer (  ) to change the
trimmed size.
➂ Click [OK].
The trimmed image only is displayed in the
window.

Trimming area
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Step 2 : Adjust the Location and Size of the Image

Adjust the layout and the size of the image. Keep adjusting the location and size until you achieve the layout you want.

Adjusting the Location

Click , then click the image.
Drag to adjust the location.

Adjusting the Size

Click , then click the image.
Drag the pointers (  ) at the four corners of the image to
adjust the size.

Pointers
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Step 3 : Enclose the Image in a Circle

Use a frame to enclose the image in a circle.

➊ At the [Object] menu, click [Frame].
The [Frame] dialog box appears.

➋ ➀ For the frame, select [03].
➁ Click [Insert].
A frame is inserted into the window.

➌ Drag the pointers (  ) around the frame to
adjust its size and location.
Adjust the location and size so as to enclose the im-
age. The adjustment methods are the same as the meth-
ods for adjusting the location and size of an image.
☞ p 42 "Step 2 :  Adjust the Location and Size of the Image"

Frame
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4-2 Tips and Tricks for Text Layout

Tips and Tricks for Text Layout

Arrange text and create data like that shown in the figure.

Dr. METAZA2 screen

Dr. METAZA2 screen

Completed view

1. Lay out the text horizontally.
☞ p 45 "1. Arranging Text Horizontally"

2. Arrange in the shape of a fan.
☞ p 48 "2. Arranging in the Shape of a Fan"

Completed view
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1. Arranging Text Horizontally

Type in the text to arrange horizontally in the image.

Procedure

➊ Go to [Object] menu, click [Text].
Select [Horizontal Text].

➋ Click the location where you want to insert text.
The [Text] dialog box appears.

➌ ➀ Go to [Text] and enter the text.
➁ Click [OK].
The text appears in the window.

You can adjust the size and layout of the entered text, and change the typeface.
☞ p 46 "Adjusting the Layout and Size of Text"

☞ p 47 "Changing the Font Style"

Line up the pointer with the location
where you want to insert.
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Adjusting the Layout and Size of Text

Changing the Size

Dragging the pointers (  ) of the text box changes the size.

Changing the Layout

Dragging the center of the text moves it up, down, or to the left or right.
You can rotate the text by dragging it at a location to either the left or right of its center.

Cursor for movement up,
down, or to the left or right

Cursor for rotation
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Changing the Font Style

Procedure

➊ Double-click the text string.
The [Text] dialog box appears.

➋ Click [Change].
The [Font] dialog box appears.

➌ ➀ Make the selections for the font, style, and size.
➁ Click [OK].
The [Text] dialog box appears again.

➍ Click [OK].
The typeface of the on-screen text changes.
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2. Arranging in the Shape of a Fan
Procedure

➊ Go to [Object] menu, click [Text].
Select [Fan Text].

➋ Click the location where you want to insert text.
The [Fan Text] dialog box appears.

➌ ➀ Go to [Text] and enter the text.
➁ Click [OK].
The text appears in the window.

You can adjust the size and layout of the entered text, and change the typeface.
☞ p 49 "Adjusting the Layout and Size of Text"

☞ p 50 "Changing the Font Style"

Line up the pointer with the location
where you want to insert.
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Adjusting the Layout and Size of Text

Changing the Size

Dragging the pointers (  ) of the text box changes the size.

Changing the Layout

Dragging the support point moves up, down, or to the left or right.
Dragging inside the text box rotates the support point around the reference.

Support point

Cursor for movement up,
down, or to the left or right

Cursor for rotation
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Changing the Font Style

Procedure

➊ Double-click the text string.
The [Fan Text] dialog box appears.

➋ Click [Change].
The [Font] dialog box appears.

➌ ➀ Make the selections for the font, style, and size.
➁ Click [OK].
The [Fan Text] dialog box appears again.

➍ Click [OK].
The typeface of the on-screen text changes.
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4-3 Adjusting Brightness and Contrast

Checking the Finished Results in the Preview Window

At the preview window, you can adjust the brightness, contrast, and gamma correction. An image with clearly defined
light and dark areas produces attractive printed results. Adjust to match the image.

Procedure

Go to the [File] menu and click [Print Preview].

Preview screen
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Tips and Tricks for Image Adjustment

What You Can Do in the Preview Window

The dark and bright areas are printed as shown in the figure.
Dark-color areas are not struck, and light-color areas are struck forcefully.

Also, the printing results before and after adjustment are as shown below.

Bright area

Dark area

Before adjusting After adjusting

Gamma adjusted to 0.4.
The brightness of the face is reduced,
making the expression clearly defined.

Gamma
This mainly adjusts the brightness of tones of
intermediate brightness between bright and dark
areas. Using it is effective in adjusting the over-
all brightness.

Brightness
This adjusts the overall brightness. Making the
value too large can destroy the balance, so it
may be a good idea to adjust it to the absolute
minimum necessary.

Contrast
This mainly adjusts highlights (the brightest ar-
eas) and shadows (the darkest areas). Using this
can be effective when you want to achieve a
sense of tension with a good balance of light
and dark.
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4-4 Printing Materials of a Wide Variety of Shapes

About the Size and Shape of the Printing Area

The size of the image to print must always fit within the size of the material. Printing an image that is larger than the
material may cause the marking pin to strike the edge of the material and break.
Dr. METAZA2 comes preset with quadrilateral, round, and diamond material shapes. When you select one of these
materials, the image is displayed matched to the shape of the material, with an appropriate margin.
For example, when you want to print material whose shape is not registered in Dr. METAZA2, like that shown in the
figure, you must set the area printed to be smaller than the material.

Registering the shape of the material with Dr. METAZA2 makes it possible to expand the printing area.
☞ p 54 "Adding a Material Shape"

Avoiding Holes in the Material When Printing

When you use the pen feature to black-fill an area in the data by drawing freehand, the filled area is not printed. When
you want to perform printing that avoids a hole in the material, use the pen to fill an area in the data whose size and
location is matched to the hole. You can make the settings for the width of the pen and the like in the [Pen Setup]
dialog box.

☞  For detailed information, refer to the online help.

Printing area
Printing cannot be performed around a hole.

Dr.METAZA2 Screen

[Pen Setup] dialog box

Be sure to specify black as the color.
In the Pen Setup dialog box, set the width of the pen to
match the diameter of the hole in the material.

Material

Printing area

Material

Hole in the material

Printing area

Hole in the material
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Adding a Material Shape

When you want to use material of a shape other than a circle (ellipse), quadrilateral, or diamond, add the shape.

Creating a Shape Using a Third-party Program

You can use a commercial paint-type program to create a shape, then register it with Dr. METAZA2. Vector data cannot
be used. Prepare bitmap data that meets the following conditions.
Number of colors : Binary (black and white -- Fill the interior of the shape with black, and make other portions white
or uncolored.)
File format : BMP or JPEG format

Alternatively, you can acquire (import) the shape of the material using a scanner. You acquire the shape by scanning
the material directly, or by making a paper copy of the shape of the material and then scanning the paper.

☞ For detailed information, refer to the documentation for the scanner you're using.
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4-5 Other Handy Features

A Wide Variety of Operations You Can Accomplish with Dr. METAZA2

Dr. METAZA2 offers a wide variety of features for editing imported images and creating printing data. For more
information on how to operate Dr. METAZA2, refer to the online help for the program.

☞  p 13 "Included Documentation"

Inserting a Frame

You can use frames to decorate images.
You can select the shape and color you want from among the registered frames.
How to display the editing screen : At the toolbar, click  (Frame). Alternatively, at the [Object] menu, click
[Frame].

Registering a Custom-made Frame

You can use a commercial paint-type program to create a shape yourself, then register it with Dr. METAZA2.
How to display the editing screen : At the [Object] menu, click [Add Parts], then click [Frame].

Rotating an Image

You can take an image imported into Dr. METAZA2 and rotate it in increments of 90 degrees.
How to display the editing screen : At the [Object] menu, click [Rotate Image].

Cropping an Image

You can crop just the necessary portion of an image. This lets you extract and print the image of a specific person, for
example, or a background image.
How to display the editing screen : At the [Object] menu, click [Crop Image].

Registering a General-use Image

You can register often-used logos and other images as symbols, which lets you call them to the screen simply and
easily. Registering as a symbol an image that allows wide use can shorten editing times. You can also import your own
original images into Dr. METAZA2 and register them as symbols.
How to display the editing screen : At the [Object] menu, click [Add Parts], then click [Symbol].

Importing a General-use Image

You can import an image registered as a symbol.
How to display the editing screen : At the [Object] menu, click [Symbol].

Importing an Image Using a Scanner

If you have a TWAIN 32-compliant scanner, you can call up the scanner driver from Dr. METAZA2. This lets you import
and print your own original images.
How to display the editing screen : At the [File] menu, click [Select Source].
How to display the editing screen : At the [File] menu, click [Acquire].
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Inverting Gradations

This inverts the gradations of all images displayed in Dr. METAZA2. You use this when you want to insert a logo or text
and print it with black and white reversed.
How to display the editing screen : At the [Edit] menu, click [Invert].

Adding Handwritten Text and Hand-drawn Images

You can use the pen tool to add hand-drawn figures and handwritten text to an image.
How to display the editing screen : At the toolbar, click [ ] (Pen).
When you display the setting window for the pen, you can specify the pen width and color.
How to display the editing screen : At the [Object] menu, click [Pen Setup].
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4-6 Items You Can Set Using the Driver

A Wide Variety Settings You Can Make with the Driver

At the setting window for the driver, you can make the settings for a wide variety of items, including the size of the
material and the method used for printing.

Displaying the Setting Window

Any changes you make at this window (the window displayed by using the procedure described here) remain in effect
even after you restart Dr. METAZA2. To continue operations with the changes applied, follow the procedure below to
display the setting window.

Procedure

➊ Windows XP
Click [Start], then click [Control Panel].
Click [Printers and Other Hardware], then click [Printers and Faxes].
Windows 98 SE/Me/2000
Click [Start].
Click [Settings], then click [Printers].

➋ Right-click [Roland MPX-70].
If you're using Windows XP/2000, click [Printing Preferences].
If you're using Windows 98SE/Me, click [Properties].
The setting window appears.

About the Setting Window

Going to the Dr. METAZA2 [File] menu and clicking [Print Setup], then, in the [Print Setup] window, clicking
[Properties], displays the same window as the one that appears using "Displaying the Setting Window," described
above.
Any changes you make while at this window disappear when you restart Dr. METAZA2. When you want to make
temporary changes in driver settings, display the setting window from Dr. METAZA2.
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Material Tab

Image Correction Tab

Select this when you want to speed up printing times.
Note, however, that printing quality may be slightly
reduced.

To view the image during printing while printing is in
progress, make sure this is selected.

This loads driver settings saved in a file.

This saves the driver settings in a file.

This corrects misalignment of the center point.

☞ p 70 "Adjusting the Location of the Machine's Origin Point"

Enter the size of the printing area.

This expands the printing area (this can be set up to a
maximum of 80 x 80 mm (3-1/8 x 3-1/8 in.).
However, note that when printing is performed in an
expanded area (that is, outside an area of 50 x 50 mm
(1-15/16 x 1-15/16 in. )), then depending on the mate-
rial and the image, unevenness in darkness may occur.

This chooses the units of measurement for the width
and length.

This chooses the composition of the material to print.
The optimal striking force for printing the composition
is set.
To fine-tune the striking force, click [Details].

☞ p 72 "Adjusting the Striking Force to Match the Material"

This selects the printing mode.
When you're printing an image with clearly defined
outlines, such as text, then select [Text]. When you're
printing an image that contains gradations, such as a
photograph, then select [Photo]. When you want to cut
even small text and intricate patterns attractively, choose
[High Resolution]. Note that the printing time when
you select [High Resolution] takes approximately twice
as long as with [Photo].

This prints a mirror image of the printing image.

This returns the corrected image values to the initial
values before correction (brightness = 0, contrast = 0,
and gamma = 0.5).

This performs adjustment when the printing results are
not what you intended.

☞ p 74 "The image is unattractive."
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Option Tab

This adjusts the tilt of the table.
Enter the values taken from the results of printing the
test pattern.

This prints the test pattern for adjusting tilt using
the machine.

☞ p 75 "The image is always faint at the same location."
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5-1 Daily Care

Daily Care

WARNING Never use gasoline, alcohol, thinner, or any other flammable material.
Doing so may cause fire.

CAUTION Never touch the heads immediately after printing has finished.
Doing so may cause burns.

➢ This machine is a precision device, and is sensitive to dust and dirt. Be sure to carry out day-to-day cleaning.
➢ Never use solvents such as thinner, benzine, or alcohol.
➢ Never attempt to oil or lubricate the machine.

Cleaning the Adhesive Sheet

If the adhesive force of the adhesive sheet declines, then wash the sheet.

➢ Never scrub the adhesive sheet using a scrubbing pad or sponge.
➢ Never stretch or bend the adhesive sheet when washing it.

Procedure

➊ Press the Power/Movement button to move the table to
the front of the machine.

➋ Switch off the power.

➌ Peel off the adhesive sheet from the table.
Grasp the edges of the adhesive sheet and peel it off slowly.

Power/Movement button

Adhesive sheet
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➍ While submersing the adhesive sheet in water, gently stroke the surface of the sheet with your
fingers.

➎ Allow the adhesive sheet to dry.
Allow to dry completely, out of direct sunlight. It must not be mounted on the table while wet.

➏ Place the adhesive sheet on the table.

➐ Press down gently on the adhesive sheet at the center and
the four corners.

Mounting the Adhesive Sheet

➢ Place it straight, aligned with the scale marks on the table.
➢ Place inside the table frame.
➢ Be careful not to allow any air bubbles to form between the adhesive sheet and the table.

If the Adhesive Sheet Gets Extremely Dirty

If the soiling of the adhesive sheet is severe, wash it using diluted neutral detergent. Rinse thoroughly with water
to remove all detergent completely.

Adhesive sheet
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Head Cleaning

Clean away any fine grime around the head. Perform cleaning periodically.

➊ Press the Power/Movement button to move the table to
the front of the machine.

➋ Remove the adhesive sheet.

➌ Switch off the power.

➍ ➀ Loosen the knob.
➁ Press the location shown in the figure to lower the head
unit to where it touches the brush.

➎ Keeping the area shown in the figure clamped, turn the
knob to secure in place.

Brush

Adhesive sheet

Power/Movement button

Knob

Head unit

Knob
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➏ Press the Power/Movement button to switch on the power.
The head moves and cleaning is performed.

➐ After cleaning has finished, loosen the knob.

Cleaning the Body and Cover

Use a cloth moistened with water then wrung well, and wipe gently to clean.
The surface of the cover is easily scratched, so use a soft cloth.

Knob
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5-2 Maintenance of the Marking Pins

The machine's head has nine pins. Printing is performed using these pins one at a time. If the tip of the pin in use
becomes worn, you can change the pin used for printing. You can also perform adjustment to ensure that each pin uses
the same striking force.
You carry out all of these maintenance activities using the included [MPX-70 Head Manager] program.

Starting MPX-70 Head Manager

➊ Click [Start], then click [All Programs] (or [Pro-
grams]).
Click [Roland Dr. METAZA2], then click [MPX-
70 Head Manager].

➋ Switch on the power to the machine.

Checking the State of the Marking Pins

The state of each pin is shown.
If the indicator for the pin you're using is red, then replace it with a new pin.
If attractive printing is impossible or printed images are uneven even though the scale is not red, then change to a new
pin.

This indicates the amount of pin usage. The indicator display
increases a little at a time as striking is performed. The rate of
increase varies according to the material printed.
Pins for which nothing is displayed are unused.

A pin needs to be replaced when it is shown in red.

This refreshes the screen to display the latest information.
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Changing the Pin Used for Marking

Follow the steps below to change the marking pin.

Procedure

➊ Start MPX-70 Head Manager.
☞  p 66 "Starting MPX-70 Head Manager"

➋ ➀ Choose the number of the pin to use next.
➁ Click [Apply Pin Change].

➌ ➀ Follow the on-screen instructions to reset the power.
➁ Click [OK].
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Adjusting the Striking Force of the Pins

You can individually adjust the striking force of each separate pin. Pin adjustment involves striking the pattern shown
in the figure. Prepare a piece of test-use printing material (brass) or other material measuring about 60 mm (2-3/8 in.)
by 60 mm(2-3/8 in.) .

Procedure

➊ Start MPX-70 Head Manager.
☞  p 66 "Starting MPX-70 Head Manager"

➋ Click [Readjust Pins].
Follow the on-screen instructions to perform adjustment for the
pins.

➌ When you have finished, click [X].
The window closes.

How to Determine the Adjustment Values

Type in the letter and number of the location where the value that can be read is lightest. If this is difficult to determine,
decide on an appearance (darkness) to serve as a reference, and select a location having the same appearance. For
instance, if the situation is like that shown in the figure, then enter the following values.

Adjustment pattern

B0

C3

B0

C2

C2

B9

C2

C1

C5
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5-3 Head Replacement

Replacing the Head

When all nine marking pins wear out, replace the head. During replacement, you strike the pattern shown in the
figure. Prepare a piece of test-use printing material (brass) included with the replacement head (MPH-70), or another
piece of material measuring about 60 mm (2-3/8 in.) by 60 mm (2-3/8 in.).
The replacement head is sold separately. Consult your authorized Roland DG Corp. dealer or Call Center.

Procedure

➢ Never quit the replacement operation while partway through.
➢ The head is a consumable part. Never use a head whose marking pins are all worn out.
➢ Never reuse a head once it has been removed. Never use it a second time, even if it contains unused pins.

➊ Start MPX-70 Head Manager.
☞  p 66 "Starting MPX-70 Head Manager"

➋ Click [Replace Head].
Follow the on-screen instructions to carry out head replacement.

➌ When you have finished, click [X].
The window closes.

After you have finished the head-replacement operation, click [Readjust Pins] to check the state of the marking pins.
☞  p 68 "Adjusting the Striking Force of the Pins"

Adjustment pattern
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5-4 Adjustment of the Origin-point Location

Adjusting the Location of the Machine's Origin Point

The machine's printing origin point is at the center of the table's scale. When you want to adjust the origin-point
location, output calibration data to verify the location of the origin point.

1. Print calibration data.

➊ Mount material on the center of the table.
Prepare material measuring at least 20 mm square.

☞  p 30 "Mounting Material on the Table"

➋ Start Dr. METAZA2.

➌ ➀ Go to the [File] menu and click [Open].
➁ For [Look in], select the [Samples] folder.
➂ Select [Axis.dmz].
√ Click [Open].

➍ Start printing.

2. Measure and type in the correction values.

➊ Measure and note down the offset between the centerline
on the table scale and the crossed lines on the material.
In the example shown in the figure, the [Width] value is displaced
by 0.5 mm in the positive direction and the [Length] value is offset
by 0.5 mm in the negative direction.

➋ Windows XP
Click [Start], then click [Control Panel].
Click [Printers and Other Hardware], then click [Printers and Faxes].
Windows 98 SE/Me/2000
Click [Start].
Click [Settings], then click [Printers].
The [Printers] folder opens.

-0.5 mm

0.5 mm

Center line

Positive direction
for [Length]

Positive direction
for [Width]

Material
Center line
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➌ Right-click [Roland MPX-70].
If you're using Windows XP/2000, click [Printing Preferences].
If you're using Windows 98SE/Me, click [Properties].
The setting window appears.

➍ ➀ Click the [Material] tab.
➁ In the width and length fields for [Offset], en-
ter the displacement values you noted in step 1.
➂ Click [OK].
The window closes.

Entry of Correction Values

When the setting window for Dr. METAZA2 is displayed, the values for any settings made there are temporary,
and are not saved.
To save the values in the setting window, go into the [Printers] folder and display the setting window for the driver.

☞  p 57 "A Wide Variety Settings You Can Make with the Driver"
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5-5 Registration of Custom Material

Adjusting the Striking Force to Match the Material

Here you register a material and adjust the striking force to match the material's hardness and other parameters.

Procedure

➊ Windows XP
Click [Start], then click [Control Panel].
Click [Printers and Other Hardware], then click [Printers and Faxes].
Windows 98 SE/Me/2000
Click [Start].
Point to [Settings], then click [Printers].

➋ Right-click [Roland MPX-70].
If you're using Windows XP/2000, click [Printing Preferences].
If you're using Windows 98SE/Me, click [Properties].

➌ ➀ Click the [Image Correction] tab.
➁ For [Material], select a custom material (settings a through
d).
➂ Click [Details].
The [Details] window appears.

➍ Adjust the impact values.
The printing results vary according to the hardness of the material. Adjust to
match the material.

➎ Click [OK].
The [Details] window closes.

➏ Click [OK].
The setting window closes.

Raise
• When dark areas of the image are not struck
Lower
• When dark areas of the image are whitish (too bright)
• When overall striking is too forceful

Raise
• When bright areas of the image are struck with too little force (too dark)
• When overall striking is too weak
Lower
• When white areas of the image are struck with too much force
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6-1 What to Do If

The machine doesn't run even when printing data is sent.

Is the power switched on?
Make sure the Power/Movement button light is on. If it is
dark, press the Power/Movement button to switch on the
power.

Is the power cord connected correctly?
If it is not connected correctly, refer to the page indicated
below and connect it properly.

 ☞  p 18 "Connecting the Power Cord"

Is the cable used for the connection to the computer
connected correctly?
If it is not connected correctly, refer to the page indicated
below and connect it properly.

 ☞  p 19 "Connecting to the Computer"

Striking is performed, but nothing is printed.

Has the height of the head been adjusted to match
the thickness of the material?
Check whether the head is at a height that matches the thick-
ness of the material and whether the head is fixed in place
at that height. Printing cannot be performed if the height of
the head doesn't match the thickness of the material. Align
the head height and fix the head in place securely using the
knob.

Is the material loaded at the correct location?
If empty printing is being performed at a location other than
where the material is loaded, then reload the material.

Is the material to be printed in line with the param-
eters for printable material?
Prepare and use printable material.

 ☞  p 28 "Preparing Material to Print"

Was printing performed at a location such as the
edge of the material?
Printing at the edge of material may bend or break the mark-
ing pin. If nothing is printed, the marking pin may be bent
or broken. Printing cannot be performed if the marking pin
is bent or broken. Change the pin.

 ☞  p 67 "Changing the Pin Used for Marking"

The image is unattractive.

Are the settings for the material in the driver's set-
ting window correct?
Choose the composition of the loaded material.
Even if the composition of the material is the same, the
hardness of the printed surface may vary greatly depending

on the casting method, the composition of impurities, the
presence of plating, and so on. In such cases, perform fine
adjustment of the striking force to match the material.

 ☞  p 72 "Adjusting the Striking Force to Match the Material"

Is the image printed clearly?
If the image is not printed clearly, adjust the brightness of
the image. Perform printing while increasing the brightness
of [Gamma] or [Brightness] in the driver's setting window a
little at a time.
At this time, leave the material loaded and perform
overstriking at the same location. Continue changing set-
tings and performing printing until you obtain the darkness
you want.

 ☞  p 57 "A Wide Variety Settings You Can Make with the Driver"

Are grayscale tones printed clearly?
If the grayscale tones is not printed clearly, adjust the force
of striking. Perform printing while leaving the value for [Im-
pact--MAX] unchanged and increasing the value for [Im-
pact--MIN] a little at a time.
At this time, leave the material loaded and perform
overstriking at the same location. Continue changing the
settings in the driver's setting window and performing print-
ing until you obtain the darkness you want.

 ☞  p 57 "A Wide Variety Settings You Can Make with the Driver"

More Information about Overstriking
The various setting values determined with overstriking are
effective only when performing overstriking under identi-
cal conditions. The same results are not necessarily obtained
when printing is performed with a new piece of material
with only the conditions made the same, without perform-
ing overstriking.

Is the marking pin worn?
Attractive printing may be impossible if the marking pin
becomes worn.
Adjust the pin or change it to a new one.

 ☞  p 66 "5-2 Maintenance of the Marking Pins"

The image is uneven.

Is the printed surface slightly uneven?
Replace with material having a level printing surface.

 ☞  p 28 "Preparing Material to Print"

Is the printed surface at an angle?
Replace with material having a level printing surface.

 ☞  p 28 "Preparing Material to Print"

Is the image darkness uneven?
Performing overstriking with the material left loaded at the
same location may improve the image quality. Try perform-
ing overstriking with different settings for [Gamma], [Bright-
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The image is always faint at the same location.

If the image is often faint at the same location, such
as near the front right area of the table, then adjust-
ing the levelness of the machine may improve the
image quality.
Please note that this is not effective when uneven-
ness in the image is unrelated to the printing loca-
tion, such as when uneven areas vary from one piece
of material or image to another.

1.Load a piece of included test-use printing material at the
center of the table.
If the included material has been used up, then prepare a
piece of material that is larger than 60 mm and has a smooth-
ness of 0.05 mm or less.

 ☞  p 30 "Mounting Material on the Table"

2.Go into the [Printers] folder. Right-click the [Roland  MPX-
70] and open the setting screen for the METAZA driver.
If you are using Windows XP/2000, click [Printing Prefer-
ences].
If you are using Windows 98 SE/Me, click [Properties].
3.Click the [Option] tab.
4.Click [Test print].
The test pattern is printed on the material.
5.Use the scale to read and note down locations where the
test pattern is not continuous or not visible. Note down the
values in all four directions (front, back, left, and right).

5 1010 1515 2020 5
5

5

10

15

20

10

15

20

RightLeft

Back

Front

6.Select [Correct slope] and enter the scale values you noted
into the driver.

The printed location isn't where desired

The center of the table scale may not coincide with the
machine's printing origin point.
To correct displacement between the scale center and the
printing origin point.

 ☞  p 70 "Adjusting the Location of the Machine's Origin Point"

What to Do If Installation Is Impossible

If installation quits partway through, or if the wizard
does not appear when you make the connection with
a USB cable, take action as follows.

Windows XP/2000

1.If the [Found New Hardware Wizard] appears, click [Fin-
ish] to close it.
2.Display [System Properties].
Windows XP
Click the [Start] menu, then right-click [My Computer]. Click
[Properties].
Windows 2000
Right-click [My Computer] on the desktop. Click [Proper-
ties].
3.Click the [Hardware] tab, then click [Device Manager].
The [Device Manager] appears.

ness], or [Contrast] in the driver's setting window.

 ☞  p 57 "A Wide Variety Settings You Can Make with the Driver"

Was bidirectional printing performed?
Bidirectional printing can shorten the printing time, but the
image quality may suffer. If this happens, go to the driver's
setting window and clear the selection for [Bidirection],
then redo printing.

 ☞  p 57 "A Wide Variety Settings You Can Make with the Driver"

Is the marking pin worn?
Attractive printing may be impossible if the marking pin
becomes worn.
Adjust the pin or change it to a new one.

 ☞  p 66 "5-2 Maintenance of the Marking Pins"
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4.At the [View] menu, click [Show hidden devices].
5.In the list, find [Printers] or [Other device], then double-
click it.
When [Roland MPX-70] or [Unknown device] appears be-
low the item you selected, click it to choose it.

6.Go to the [Action] menu, and click [Uninstall].
7.The screen shown in the figure appears.
Click [OK].

8.Close the [Device Manager] and click [OK].
9.Unplug the USB cable from your computer.
10.Restart Windows, then uninstall the driver.

 ☞   p 76 "Uninstalling the Driver"

11.Redo the installation from the beginning.

 ☞  p 21 "Installing the Driver"

Windows 98 SE/Me

1.Refer to "Uninstalling the Driver" on the following page
and uninstall the driver.

 ☞  p 76 "Uninstalling the Driver"

2.Redo the installation from the beginning.

 ☞  p 21 "Installing the Driver"

Uninstalling the Driver

When uninstalling the driver, perform following op-
eration.
1.Before you start uninstallation of the driver, unplug the
USB cables from your computer.
2.Log on to Windows. If you are installing under Windows
XP/2000, log on as “Administrators” right.
3.Insert the included CD-ROM into the CD-ROM drive.
The setup menu appears.
Go to the upper right and click the [X] to close the setup
menu.
4.From the [Start] menu, click [Run].

5.For [Open], type in the information shown below, then
click [OK].
Windows XP/2000
(CD-ROM drive letter ):\Drivers\WIN2K\SETUP.EXE
Windows 98 SE/Me
(CD-ROM drive letter):\Drivers\WIN9X\SETUP.EXE
The Setup program starts and the [Driver Setup] window
appears.

6.Select [Uninstall], then choose [Roland MPX-70].
Click [Start].

7.Click [Yes] to restart the computer
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6-2 When Moving the Machine

When moving the machine, be sure to attach the protective material. Moving the machine without attaching the
protective material may result in damage to the machine.

Procedure

➊ Loosen the knob.
Loosen just enough for the head unit to rise.

➋ Press the Power/Movement button to move the table to the front of the machine.

➌ Switch off the power.

➍ Attach the protective material.

➎ Lower the head unit and use the knob to secure it in place.
Press down on the entire head unit with your hand.

➏ Repack the machine in its original packing carton.

Protective material

Fit the side in.

Align the front.

Insert the narrow portion at the front at an angle.

Head unit
Stainless-steel portion

Protective material
Table

Head unit

Knob
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6-3 Head Life

The head used in this machine is a consumable part.
As a general guide to its useful life, about 3,600 plates can be printed under the following conditions.

Conditions of Use

Material used : MD-NI (Roland nickel-plated plate)
Printing area : 30 mm (1-3/16 in.) X 23 mm (15/16 in.)
Print Mode : Photo
Printing rate : 35% (25,000 dots per plate)
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6-4 Locations of the Power Rating and Serial Number Labels

Power Rating
Use an electrical outlet that meets the re-
quirements for voltage, frequency, and am-
perage given here.

Serial Number
This is require when you seek maintenance,
servicing, or support. Never peel off the label
or let it get dirty.
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6-5 Main Unit Specifications

Printable material

Loadable material size

Printing area
Resolution
Printing direction
Printing speed (Default)
Interface
Power supply

Power consumption
Acoustic noise level
Operation temperature
Operation humidity
External dimensions

Weight
Packed dimensions

Packed weight
Accessories

MPX-70
Gold, silver, copper, platinum, brass, aluminium, iron, stainless steel, etc.
(Vickers hardness [HV] of the printing surface must be 200 or less.)

Maximum  90 mm (width) x 90 mm (height) x 20 mm (thickness)
(3-1/2 in. x 3-1/2 in. x 3/4 in.)

80 mm x 80 mm (3-1/8 in. x 3-1/8 in.)

529 dpi(High resolution), 353 dpi (Photo), 265 dpi (Text)

Unidirectional printing or bidirectional printing (Selectable with Windows driver)

50 mm/sec  (1-15/16 in./sec)(Photo), 33 mm/sec  (1-5/16 in./sec)(High resolution/Text)

USB interface (compliant with Universal Serial Bus Specification Revision 1.1)

Dedicated AC adapter
Input : AC 100 to 240V ± 10%  50/60Hz  1.7A
Output : DC 19V  2.1A

Approx. 15W

Under 70 dB (A)  (According to ISO 7779)

10 to 30˚C  (50 to 86˚F)

35 to 80%  (no condensation)

226 mm (W) x 321 mm (D) x 200 mm (H)
(8-15/16 in. (W) x 12-11/16 in. (D) x 7-7/8 in. (H))

4.0 kg (8.8 lb.)

350 mm (W) x 440 mm (D) x 350 mm (H)
(13-7/8 in. (W) x 17-3/8 in. (D) x 13-7/8 in. (H))

6.5 kg (15 lb.)

AC adapter, power cord, test-use printing material, USB cable, CD-ROM, user's manual
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Please read this agreement before opening the sealed disk package

Opening the sealed disk package implies your acceptance of the terms and conditions of this agreement.

Roland License Agreement

Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in the disk package ("Software") under this agreement with the following terms and conditions.

1. Coming into Force
This agreement comes into force when you purchase and open the sealed disk package. The effective date of this
agreement is the date when you open the sealed disk package.

2. Property
Copyright and property of this Software, logo, name, manual and all literature for this Software belong to Roland
and its licenser. The followings are prohibited:
Unauthorized copying the Software or any of its support file, program module or literature.
Reverse engineering, disassembling, decompiling or any other attempt to discover the source code of the Soft-
ware.

3. Bounds of License
Roland does not grant you to sub-license, rent, assign or transfer the right granted under this agreement nor the
Software itself (including the accompanying items) to any third party.
You may not provide use of the Software through time-sharing service and/or network system to any third party
who is not individually licensed to use this Software.
You may use the Software by one person with using a single computer in which the Software is installed.

4. Reproduction
You may make one copy of the Software only for back-up purpose. The property of the copied Software belongs
to Roland.
You may install the Software into the hard disk of a single computer.

5. Cancellation
Roland retains the right to terminate this agreement without notice immediately when any of followings occurs:
When you violate any article of this agreement.
When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability
Roland may change the specifications of this Software or its material without notice.
Roland shall not be liable for any damage that may caused by the use of the Software or by exercise of the right
licensed by this agreement.

7. Governing Law
This agreement is governed by the laws of Japan, and the parties shall submit to the exclusive jurisdiction of the
Japanese Court.

Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
h�p://myh66.com

h�p://usermanuals.us
h�p://www.somanuals.com

h�p://www.4manuals.cc
h�p://www.manual-lib.com
h�p://www.404manual.com
h�p://www.luxmanual.com

h�p://aubethermostatmanual.com
Golf course search by state

h�p://golfingnear.com
Email search by domain

h�p://emailbydomain.com
Auto manuals search

h�p://auto.somanuals.com
TV manuals search

h�p://tv.somanuals.com

http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

